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Chapter 1 Introduction
1.1 General Information
The Remote Printer Management Utility , shortly named RPMU, is a software tool for network
administrators that allows the configuration and control of Printronix Serial Dot Matrix S809 and S828
remotely connected to the Ethernet LAN.
With this tool the installed printers may be controlled, configured and organized easily.
The main features are the following:
Device Discovery: searches for the devices within a range of IP addresses.
Printer Organization: the printers connected to the network can be organized into logical groups
in a hierarchically structured tree.
Printer Status Report: checks the printer’s status and reports alarms.
Printer Configuration: the remotely connected printers may be configured as needed from the
administrator’s workstation.
Firmware Updating: provides a firmware downloading function to upgrade both the base and the
LAN card firmware.
Remote Operator Panel Management: provides a virtual operator panel for the remotely
connected printer at the administrator’s workstation that allows to perform all functions normally
achieved pressing the operator panel keys.
The RPMU also provides the basic status management for third-party printers compliant to the standard
MIB objects.

1.2 Operating S ys tem C ompatibility
The RPMU is a Java based application and can be run on any platform supporting the Java Run Time
Environment version 6 or newer.

1.3 P rinter F irmware C ompatibility
The RPMU release 2.12 can be used with the Serial Matrix Printers S809 and S828 only.

RPMU-AM
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Chapter 2

Installing the RPMU in Windows Environment

2.1 Installation Steps
1) The RPMU needs Java Virtual Machine (JVM) fully version 6 compliant, which can be downloaded
from http://javacom web site and the Printronix installation file which can be downloaded from
http://Printronix.com for the specific operating system.
For Windows O.S. platform the tool installation file is: RPMU-2.12-windows-installer.exe
2) After installing JRE, run the SETUP.exe file (be sure to have Administrator rights) and
Instructions. Install it in a subfolder (i.e.: C:\RPMU)

RPMU-AM

2

follow the

260074-001A

RPMU Administrator’s Manual
3. Run RPMU (executable prtmng.jar file) from the shortcut of desktop.

The RPMU displays the Login window:

4. Default User is “admin”; Default Password is “admin”; and after the login and password entry the
main window appears:

RPMU-AM
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2.2 How to change Password
To change Password push the button “Change User or Password into the Login Dialog.
It will show the below window:

Insert new User or New password and Old Pwd in the appropriate textbox and at last click on the button
“Modify”.

RPMU-AM
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Chapter 3 The RPMU Menu
3.1 The RPMU Main Window
The RPMU Main Window, shown in the following figure, is divided mainly into three parts:
the Menu Bar
the Tool Bar
the printer database window, whereas the management tools displays the Printer Database
Information.

The Menu B ar contains the six menus (File, Edit, Status,Scan,Printer Operations and Help)
used to control the functions of the program.
The T ool B ar contains the icons of the shortcuts for the most commonly used menu functions.
The P rinter Databas e window shows an organized list of printers, configuration files, and firmware
download files.
The following is a brief description of these screen areas.

3.2 T he Menu B ar
The RPMU menu bar is located at the top of the main window and provides the following items:

File Menu
Edit Menu
Status Menu
Scan Menu
Printer Configuration Menu
Help Menu

RPMU-AM
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3.2.1 The File Menu
The File pull-down menu offers the main file management functions for the printer databases.

New Database
Open Database

To create a new database file.
To open an existing database.

With the RPMU you can open only one database at a time. If a database is already open, you are asked to
save changes to the current database before creating the new one.

Save To File
Exit

To save the current database file. The program prompts the user to enter a name
for the file.
To end the RPMUprogram.

3.2.2 The Edit Menu
This menu allows you to manage the printer database contents: folders, printer devices, configuration
files, or firmware download files.

Insert

To add a folder, a printer device, configuration file, or firmware download file in
a previously selected folder. A corresponding icon is placed in the folder:

The example below shows the database “Network Scan” containing the folder “Scan Folder” with some
printer icons:

RPMU-AM
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The Insert item offers the following selections:

Folder The program prompts for the name of the new folder to be added.
Enter the folder name and click OK.

Printer

RPMU-AM

The program displays a data entry dialog to record printer identification values
and network parameters.
The data entry dialog is divided into two different parameter groups: Identification
and Net
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Name
Model

User
Password

Enter an easily identifiable name for the printer.
This is a read-only field. The printer model is inserted by the program as soon as
it has discovered the printer identified by the IP address (in the Net parameter
group).
Read only – name of printer’s User
Read only – password(encrypted) of the user

IP Address
Netmask
Port
Timeout
Workgroup

Enter the printer’s IP Address in this field.
Enter the Netmask that identifies the printer connection.
rfu
rfu
Enter the printer’s Workgroup in this field *

As soon as the new printer data are confirmed, the RPMUtries to contact the printer to
update its current status.
If the printer is not found within the time indicated as Timeout, the RPMU displays the printer in the
database as “not ready”.
Configuration File

Selecting the Configuration File item, the program shows the following prompt,
where you can enter the name of the configuration file, or look for it on your
computer by pressing the Browse button.

Pressing OK allows the RPMU
Utility to insert the selected configuration file into the current
folder. See also “Inserting a Configuration File into a Folder” and “Configuring the Printers in the
Database”, later in this manual.
Firmware File

Selecting the Firmware File item, the program shows the following prompt, where
you can enter the name of the firmware file you want to download directly, or look
for it on your computer by pressing the Browse button.

Pressing OK allows the RPMUto insert the selected firmware file into the current folder.
See also “Inserting a Firmware File into a Folder” and “Updating the Printer’s Firmware Version” later
in this manual.

RPMU-AM
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Cut
Copy
Paste
Delete

Selecting this function removes the selected item (folder, printer or file) from the
database and copies it into the paste buffer.
Selecting this function copies the selected item into the paste buffer.
The selected item remains unchanged.
The item inserted in the paste buffer (with the Cut or Copy function) is put in the
selected position in the database tree.
The selected item is removed permanently from the database.

3.2.3 The Status Menu

Check Now

Selecting this function the Remote Printer ManagementUtility performs a check on
all printers connected to the network and updates all the printer status.
Check List Printers W/E Selecting this function the Remote Printer Management Utility performs a check on
all printers connected to the network and will show only the printers that are
“On-line” or “Warning” or in “Alarm” status as for the user selection.

Check Periodically

Flag for enabling or disabling the status polling. When the periodical check is
selected the RPMUperforms an automatic check every about 10
seconds.
See also “Checking the Printer Status” later in this manual.

3.2.4 The Scan Menu

Printers Net Scan(insert)

RPMU-AM

The RPMU searches for the connected printers within a specified
IP-address range by sending a burst of directed
SNMP requests to each IP address within the range.
The printer find in the range are inserted into the existing Database.
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Printers Net Scan(new)

The RPMU Utility
searches
for the connected printers within a
specified IP-address range by sending a burst of directed SNMP
requests to each IP address within the range.
The current database is closed, and a new database is created

3.2.5 The Printer Operations Menu

Printer Configuration

Edit the configuration file of the selected item (printer) of the database

Operator Panel

Select the printer for which you want to see the virtual operator panel.
Selecting this function the RPMUthe corresponding operator
panel appears on the screen.

Capture Printer Infos

Selecting this function the RPMU get the configuration from printer
device and the configuration value are show.

Reboot Printer

Selecting this function the RPMU reboot the selected printer on
the database .

Manage Lock
Printer Menu

Selecting this function the RPMU lock or unlock the printer menu.

RPMU-AM
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3.3 The Tool Bar

The tool bar shows a series of icons that allow an easier access to the menu functions:
Delete an object

Open a new database
Create a new database

Expand the information tree

Add a new folder

Reduce the information tree
Send a firmware file to the devices

Save database
Add a new printer

Send a configuration file to the
devices

Add a new firmware file

Edit a configuration file
Remote Panel management

Add a new configuration file
Cut an object

Get the configuration from a device

Copy an object

Printer net scan (for update)

Paste an object

Printer net scan (new)

Edit an object’s field

RPMU-AM
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Chapter 4 Setting up the Printer Database
4.1

General

The RPMU’s main
database.

features

are the collection, organization, and management of the printer

The database may be set up manually or with an automatic discovery feature, with which the program
searches for the connected devices and automatically inserts them into the current database file.

4.2 Graphic Conventions Used in the NVM
The graphics used in the RPMU windows have the following meanings:
This symbol appears beside the folders and printer symbols. When clicking on it, the
object view toggles between the expanded (
) and the collapsed (
) view, that is the
details for the object are shown or hidden.
The printer in the database is ready and working normally.
The printer in the database is ready and working, but a consumable is running out. The
printer will probably need an operator’s intervention soon.
The printer in the database is in alarm or standby - no more jobs will be printed. An
operator’s intervention is necessary.
The printer connection is lost. An operator intervention is necessary. The printer has been
removed or the connection is interrupted.
Configuration file. The configuration file may be inserted into a folder to indicate the current
configuration of the printers in that folder.
Firmware file. The firmware file may be inserted into a folder to indicate the current firmware
version of the printers in that folder.

4.3 Automatic Device Discovery
This procedure is useful for setting up the printer database for the first time.
The RPMU searches
for
the
connected printers within a specified IP-address range by
sending a burst of directed SNMP requests to each IP address within the range.
During the device discovery procedure the RPMU maps Printronix Serial Matrix Printers
for complete management, getting the proprietary MIB objects supported. Third-parties vendors devices
are mapped for basic status reporting only.

4.4 How to Start the Automatic Device Discovery
The first-time automatic device discovery is started pressing the
bar.

RPMU-AM
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The following mask is displayed:

The From and To IP-addresses define the start and stop addresses of the range in which the
connected printers will be checked. Mask defines the Netmask for the search procedure.
The value set for Time out defines the time the program waits for a reply from a device connected
to each IP-address. If no printer is detected, after the time has passed, the program goes to the next IP
address within the range. The time-out setting is useful when performing a device discovery
procedure on large networks that normally take a long time. The time-out ranges between 300
milliseconds and 100 seconds.
The value set for Workgroup in text area defines the workgroup name of printers to be searched.
The value set for “Search for Printer containing text” defines the text to be searched into the printer
name.
Once the printers connected to the network have been discovered and identified with their IP- address,
they may be grouped in a logical way so that the user can access them quickly and easily.

The logical groups can be defined hierarchically allowing the navigation through nested device
groups. The discovered printers may then be placed into each group.
This structured database can be saved to disk and then retrieved.
The organization process of the devices is performed through the following functions:

RPMU-AM
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4.5 Create a New Database
This is the starting procedure for organizing your printers.
With the RPMU it is possible to create various printer databases and then organize the
corresponding printers into folders and subfolders, reproducing the structure of single offices,
departments, or the whole company.

1. To create a new database, press the
appears:

button on the tool bar. The database name request

2. Enter a database name.
Now you can structure and organize the database as follows:

4.6 Adding a New Folder
1. Select Edit Insert Folder or press the
prompts for the folder name:

button on the RPMU’s tool bar. The RPMU

2. Enter a name for the printer group you want to create and then click on the OK button.

The RPMUis able to manage nested folders. The printer database
may be structured as needed.

4.7 Organizing the Folders
Reorganize the Printers Already Present in the Database
If you performed the automatic device discovery procedure described above, you will already have a list
of printers connected to the network. In this case you have to reorganize these printers in the folder
structure you created with the cut and paste procedure:
Select the printer to put in the new folder and press the

button (or select Edit Cut).

Select the folder in which you want to put the printer and press the
Edit Paste).

button (or select

The printer and the corresponding information now appear in the folder.

RPMU-AM
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4.8 Inserting a Printer Manually
To insert a printer manually at any time while organizing the database, as either the first printer or in
addition to the existing printers in the database, proceed as follows:

1. Select the folder in which you want to insert the printer and press the
(or select Edit Insert Printer).

button on the tools bar

2. The RPMUdisplays the printer data dialog box, in which the user must enter the
printer’s parameters. It is necessary to specify the printer name (Identification parameter group),
the IP Address, and Netmask (Net parameter group).

For further details on how to fill in these masks, see “The Edit Menu”.
As soon as the new printer data are confirmed, the RPMU Utility
order to update its current status.

tries to

contact

the printer in

If the printer is not found , the RPMU displays the printer in the database as “not
ready”.

4.9 Inserting a Firmware File into a Folder
A firmware file may be inserted into a folder to indicate the firmware version loaded on the printers
contained in this folder.
1. Press the
button on the tool bar (or select Edit Insert Firmware File), the following
window appears:

RPMU-AM
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2. Press the “browse …” button, select the firmware file you want to insert into the folder, and press
OK.
3. 3. The firmware file is shown in the selected folder with its identifier graphics

No firmware download is performed when inserting the firmware file into the folder.
For information on how to download a new firmware version to the printers, see “Updating the Printer's
Firmware Version”.

More than one firmware file can be added to each folder.

Inserting a Configuration File into a Folder
A configuration file may be inserted into a folder to indicate the configuration set on the printers contained
in this folder.
1. Press the
button on the tool bar (or select Edit Insert Configuration File), the following
window appears:

2. Press the “browse …” button, select the Configuration File you want to insert into the folder, and
press OK.

3. The Configuration File is shown in the selected folder with its identifier graphics

No configuration updating is performed when inserting the configuration file into the folder.
For information on how to update the configuration of the printers, see “Configuring the Printers in the
Database”.

More than one configuration can be added to each folder.

RPMU-AM
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4.10 Changing the Database Structure
To further organize the folders, printers, firmware, and configuration files inserted in the database, the tool
bar offers the following buttons:
Cut an object
Copy an object
Paste an object
Edit an object’s field
Delete an object

4.11 Optimizing the Database Display
The various folders, subfolders, and printer information may be expanded or hidden in order to optimize
the information in the database window. For this purpose use the tool bar buttons:

Expand the display of the information

Hide the information tree.

You may also click on the
symbol, in the database window, to toggle between the expanded and
reduced view of the information tree.

RPMU-AM
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Chapter 5 Printer Database Management
5.1 Checking the Printer Status
Use RPMU program to check the status of the printers connected to the network
. The Status Function in the RPMU menu offers two selections:

Check Now

RPMU performs a check on all the peripherals in the
database and updates their statuses.

Check List Printers W/E

Selecting this function the RPMU performs a check on all
printers connected to the network and will show only the printers that are
“On-line” or “Warning” or in “Alarm” status as for the user selection.

Check Periodically

A flag for enabling or disabling the status polling. When the periodical
check is selected the RPMU performs an automatic check
every about 10 seconds.

After the check the printers in the database are shown with the corresponding status indication:

The printer in the database is ready and working normally.
The printer in the database is ready and working, but a consumable is running out. The
printer will probably need an operator’s intervention soon.
The printer in the database is in alarm or standby - no more jobs will be printed. An
operator’s intervention is necessary.
The printer connection is lost. An operator intervention is necessary. The printer has been
removed or the connection is interrupted.

5.2 Configuring the Printers in the Database
The RPMU allows you to read a printer’s configuration, edit it, store it to disk and download
the updated configuration to the printer.
The best way to proceed is to read the existing configuration from the printer and to change it then as
necessary.

RPMU-AM
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5.2.1 Retrieving a Configuration from a Printer
This feature is only available for Printronix S809 and S828 Printers
1. Choose the printer configuration you want to upload. You have two methods:
Open the saved configuration file previously uploaded by pressing the
via the “Printer Configuration” into the “Printer Operation” menu.

button on the tool bar or

Upload the configuration file with the current settings for the printer by pressing the
the tool bar or via the “Capture Printer Infos” into the menu “Printer Operation”.

button on

The RPMU opens the Configuration Editor showing the configuration tree for editing.

RPMU-AM
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For each parameter you can see the range of possible choices and the default setting by clicking on the
parameter in the tree. (The following shows the Form Length parameter as an example).

RPMU-AM
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5.2.2 Editing a Printer Configuration
For each parameter in the printer configuration tree you can select the desired value.
1. Click on the configuration parameter you want to set. The Printer Configuration Manager
displays, in the lower part of the window, the default value and the currently set value of the parameter.

2. Click on the
symbol on the right side of the current value; the pull-down list of the possible values
is shown for selection.
3. Click on the value shown in the current value field. The pull-down menu closes and the new value is set.
Set all the parameters in the same way.

The values set are only stored in your PC’s RAM; no value has been set on the
printers in the database.
You may now send the new settings to the printer and/or save the configuration file with the new settings
on the hard disk of your PC.

RPMU-AM
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5.2.3 Sending the Configuration to the Printers
Once all the parameters in the configuration tree have been set the new configuration must be sent to the
printers.
1. In the Printer Configurator Menu, click on Configuration. You have two download possibilities:

Selecting:
Send Modified Values:

Only the updated values are sent to the selected printers. This procedure
is faster.

Send All Values:

The whole set of configuration parameters is sent to the printers.
This procedure assures that all configured printers have identical
settings.

Restore Default Configuration

Restore the default Configuration into the working configuration file
(not sent to printer).

2. Selecting either Send Modified Values or Send All Values in the Printer Configurator Menu, the printer
asks to confirm the selection:

Selecting:
Yes
No
Cancel

Downloading of the updated configuration begins (see next step 3).
The configuration is not downloaded and the RPMU displays again the
Main Window.
The configuration is not downloaded and the Printer Setup tree is displayed for further
changes.

3. Selecting Yes sends the updated configuration to the printer.

RPMU-AM
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The program shows the progression bar during the download. At the end of the download procedure the
printer is restarted with the new settings.

5.2.4 Saving the Configuration File to Disk
Once all the parameters in the configuration tree have been set, the configuration may be saved to disk.
This allows you to have different configuration files with which to update your printers.
1. After having edited the configuration tree, select File in the Printer Configurator Menu.

2. Select Save. The RPMUprompts for a file name and folder.
3. Enter a name for the configuration file and press OK.
4. The configuration file is saved to disk. You may load it for editing and/or updating a printer with these
settings.

5.2.5 Updating a Printer or a Group of Printers Using an Existing
Configuration File
The configuration files on the hard disk of your computer may be used to update the printers in
the network, for example, when new printers are installed and should be configured as the other printers
in the same group or for reconfiguring all printers of a group. Proceed as follows:

RPMU-AM
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1. In the Main Window of the printer database position the cursor on the folder containing the printers to
configure, then press the
button. The program shows the configuration file selection window:
2. Enter the file name, or select the browse… button to select a configuration files:
Default.cfg
Tree.cfg

The RPMU shows the list of the devices that are compatible with the selected configuration file.

In this mask, you may select or deselect the printers that you want to configure by pressing on check field
(
) beside the printer or pressing on the first lower button:
Unselect All/Select All
Save Result

RPMU-AM

Pressing this button, selects or unselects all printers in the list.
Pressing this button, save in the selected .TXT file the list of the devices
compatible shown and with all information.
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Once the printers are selected, press the Send button. The Configuration File starts to download.

The first line on the screen indicates the printer that is being configured.
The second line indicates the parameter that is being updated.
Once the printers have been configured the RPMU shows the result of the download:

If the download was successful, the printer is checked with a green check sign:

If an error occurred during the download, the printer is checked with a red cross sign:

When the configuration parameters have been sent to the printer, it is reinitialized to set the new printer configuration.
After a group of printers has been updated, insert the configuration file used for the update into the folder
containing the updated printers. See “Inserting a Configuration File into a Folder”.

RPMU-AM
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5.2.6 Updating the Printer’s Firmware Version
The firmware downloading utility allows you to upgrade either the base board or the LAN card flash
content.
A single download operation can be done on a list of peripherals belonging to the same Folder in the
Printer Database.
Proceed as follows:
1. In the RPMU Main Window select the folder containing the printers for which you want
to update the firmware, and press the

button on the tool bar.

2. The program displays the firmware file selection window:

3. Enter the file name or select the browse… button to select the firmware file.

RPMU-AM
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The RPMU shows the list of printers that are compatible with the selected firmware file.

In this mask, you may select or deselect the printers to which you want to download the firmware file by
pressing the check field (
) beside the printer or pressing on the first lower button:

Unselect All/Select All
Save Result

Pressing this button, selects or unselects all printers in the list.
Pressing this button, save in the selected .TXT file the list of the devices
compatible shown and with all information.

Press the Send button to start downloading the Firmware Files to the selected printers.
When the printers have been updated the RPMU shows the result of the download:
If the download was successful, the printer is checked with a green check sign:

If an error occurred during the download, the printer is checked with a red cross sign:

After firmware downloading the printer is restarted with the new code release.
After a group of printers has been updated, insert the configuration file used for the update into
the folder containing the updated printers. See “Inserting a Firmware File into a Folder”.

RPMU-AM
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5.2.7 Configuring a Printer With the Virtual Operator Panel
For Printronix Printers, you can call up the corresponding virtual operator panel with all the keys, leds,
and the display.
You can then perform all printer operator panel functions on your computer in the same way as if you
were in front of the printer. Click on the operator panel keys with your mouse.
The following shows the virtual operator panel of the S809 printer.

For more details on the operator panel functions, please see the user manual of the
printer.

RPMU-AM
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To call up the virtual operator panel:
1. Select the printer for which you want to see the virtual operator panel.
a. Press the

button on the tool bar or via the “Operator Panel” into the menu “Printer Operation”.

2. . The corresponding operator panel appears on the screen.

For more details on the operator panel functions, please see the user manual of the
corresponding printer.

5.2.8 Updating the Printer’s List in the Database
When printers are connected to or removed from the network, you can update the structure by performing
an update net scan. During the device discovery procedure the RPMU maps Printronix Printers for
complete management getting the proprietary MIB objects supported.
Third-party vendor devices are mapped for basic status reporting.

The update automatic device discovery is started by pressing the
Tthe name of the Database, the following mask is displayed:

button on the RPMU’s tool bar. After

The From and To IP-addresses define the start and stop addresses of the range in which the
connected printers are checked. Mask defines the Netmask for the search procedure.
The value set for Time out defines the time the program waits for a reply of a device connected to each
IP- address. After the time has passed, if no printer is detected, the program goes to the next IP
address within the range. Setting of the Time-Out is useful when performing a device discovery procedure
on large networks.
The value set for Workgroup in textbox defines the workgroup name of printers to be searched.
The value set for “Search for Printer containing text” defines the text to be searched into the printer
name.
Once the printers connected to the network have been discovered and identified with their IP- address,
they may be grouped in a logical way so that the user can access them quickly and easily.

RPMU-AM
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Discoveries are started only selecting the corresponding button on the RPMU tool
bar.
No means for automatically detecting new devices are provided.
The printers found may be organized as described before in this manual.
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Appendix A
Software Installation and Documentation
The RPMUsoftware can be downloaded from our website at www.Printronix.com
-

Remote Printer Management Utility installation files
Auto Installation for Microsoft environment
Java Run Time Environment version 6
Installation shell script for Unix and Linux environments
User Guide in PDF format
Software license agreement

Trademarks:
Printronix is the trademark of Printronix.
Java and all Java-based trademarks are trademarks of Sun Microsystems,Inc. in the United States, other
countries, or both.
Linux is a trademark of Linus Torvalds in the United States, other countries, or both.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.
Other company ,product,or service names may be trademarks or service marks of others.
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Appendix B
Customer Support

P rintronix C us tomer S upport C enter
IMPORTANT

Please have the following information available prior to calling the Printronix
Customer Support Center:

•
•

Model number

•
•

Installed options (i.e., interface and host type if applicable to the problem)

Serial number (located on the back of the printer)
Configuration printout:
Press PRT CONFIG on the control panel, then press ENTER.

•

Is the problem with a new install or an existing printer?

•
•

Description of the problem (be specific)
Good and bad samples that clearly show the problem (faxing or emailing
these samples may be required)

Americas

(714) 368-2686

Europe, Middle East, and Africa

(31) 24 6489 311

Asia Pacific

(65) 6548 4114

China

(86) 800-999-6836

http://www.printronix.com/support.aspx

P rintronix S upplies Department
Contact the Printronix Supplies Department for genuine Printronix supplies.
Americas

(800) 733-1900

Europe, Middle East, and Africa

(33) 1 46 25 19 07

Asia Pacific

(65) 6548 4100

China

(86) 400-886-5598

http://www.printronix.com/supplies-parts.aspx
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Corporate Offices
Printronix, LLC.
6440 Oak Canyon Rd, Suite 200
Irvine, CA 92618
U.S.A.
Phone: (714) 368-2300
Fax: (714) 368-2600
Printronix Inc.
c/o Printronix Nederland BV
Bijsterhuizen 11-38
6546 AS Nijmegen
The Netherlands
Phone: (31) 24 6489489
Fax: (31) 24 6489499
Printronix Schweiz GmbH
3 Changi Business Park Vista
#04-05 AkzoNobel House
Singapore 486051
Phone: (65) 6548 4100
Fax: (65) 6548 4111
Printronix Commercial (Shanghai) Co. Ltd
Room 903, 9th Floor
No. 199, North Xizang Road
200070 Shanghai P.R. China
Phone: (86) 400 886 5598
Fax: (8621) 61171256
Printronix India Pvt Ltd
B-808/809, BSEL Tech Park
8th Floor, Sector 30A
Vashai Navi Mumbai 400705
India
Toll Free No.: 1800 102 7896
Fax: (9211) 4158 5555
Visit the Printronix web site at www.printronix.com
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